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Avaya Solution & Interoperability Test Lab

Application Notes for Nuance OpenSpeech Attendant with
Avaya Interactive Response — Issue 1.0

Abstract

These Application Notes describe the configuration steps required to integrate the Nuance
OpenSpeech Attendant with Avaya Interactive Response and Avaya Communication Manager.
Nuance OpenSpeech Attendant allows callers to speak the name of a person, department,
service, or location and be automatically transferred to the requested party without waiting to
speak to an operator.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the configuration steps required to integrate the Nuance
OpenSpeech Attendant with Avaya Interactive Response and Avaya Communication Manager.
Nuance OpenSpeech Attendant allows callers to speak the name of a person, department, service,
or location and be automatically transferred to the requested party without waiting to speak to an
operator.

Figure 1 illustrates the configuration used to verify the Nuance OpenSpeech Attendant (OSA)
solution with Avaya Interactive Response (IR), Avaya Communication Manager, and the Nuance
Speech Server. Nuance OSA is deployed on a dedicated application server running Windows
2003 Server. Avaya IR interfaces to Avaya Communication Manager using T1 or Voice over IP.
This solution may be supported with either interfaces, but these Application Notes will focus on
the T1/Robbed-Bit Signaling interface. Avaya IR manages the interactions with speech server
resources (i.e., speech recognition and text-to-speech) used by VXML applications. VXML
pages generated by Nuance OSA are loaded and interpreted by Avaya IR, which controls the
interaction with the user. To access the Nuance OSA application, a voice channel on Avaya
Interactive Response must be configured to invoke the VXML application when an incoming
call is received on that channel.

e

2.0
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(192.45.120.54)

Nuance OSA
Router (192.45.122.135)

Avaya G650 Media Gateway
(CLAN: 192.45.120.75)
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T1 (192.45.122.134)
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Avaya Interactive Response
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Figure 1: Configuration with Avaya Interactive Response and Nuance OSA
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1.1. Equipment and Software Validated
The following equipment and software were used for the sample configuration:

Equipment Software
Avaya Interactive Response 3.0 with Service Pack 2
Avaya S8700 Servers with a G650 Avaya Communication Manager 4.0
Media Gateway (R014x.00.1.731.2)
Avaya 4600 Series IP Telephones 2.8 (H.323)

Nuance OpenSpeech Attendant (OSA) | 3.0 with Hotfix 300HF04

Nuance Speech Server

= Nuance Recognizer 9.04
= Nuance RealSpeak 4.5
= Nuance MRCP Server 5.0.3
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2. Configure Avaya Communication Manager

This section describes the configuration of the T1/Robbed-Bit Signaling link between Avaya
Communication Manager and Avaya IR and the stations that correspond to each Avaya IR port.
In addition, it covers the configuration of the Hunt Group, Vector Directory Number (VDN),
Vector, and Agent Login-IDs required for this solution. Refer to [1] and [2] for additional
information on configuring Avaya Communication Manager. The configuration described below
covers the following capabilities:

= Establish the T1 interface between Avaya Communication Manager and Avaya IR.

= Configure stations for the Avaya IR ports. Avaya IR ports are configured as Stations
(79110-79123) with type DS1FD.

= Configure the Hunt Group that the Avaya IR ports (i.e., Agent Login-1Ds) will log into.

= Configure the Agent Login-IDs for the Avaya IR ports. Stations associated with Avaya
IR ports automatically log into the hunt group via Agent LoginlDs (29110-29123).

= Configure the VDN that receives incoming calls. Inbound calls are routed to VDN 75200
which invokes Vector 200.

= Configure the Vector that is invoked by VDN 75200. Vector 200 queues the incoming
call to Hunt Group 270 with Avaya IR ports. Vector 200 passes the DNIS and VDN
numbers to Nuance OSA which in turn returns the transfer-to number using the
configured Converse Data Return Code.

The following configuration is performed via the System Access Terminal (SAT). On the SAT,
configure the DS1 board that provides T1 connectivity to the Avaya IR. The Signaling Mode of
the DS1 board is set to robbed-bit signaling with a Line Coding and Framing Mode of ami-zcs
and d4, respectively.

add dsl 1a09 Page 1 of 1
DS1 CIRCUIT PACK
Location: 01A09 Name: AVAYA IR
Bit Rate: 1.544 Line Coding: ami-zcs
Line Compensation: 1 Framing Mode: d4

Signaling Mode: robbed-bit

Interface Companding: mulaw
Idle Code: 11111111

Slip Detection? n Near-end CSU Type: other

Figure 2: DS1 Circuit Pack
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Configure each Avaya IR port as a station with the Type field set to DS1FD. Repeat this
configuration for each Avaya IR port. In this configuration, 24 IVVR ports were configured with
an extension range of 79110 to 79123. These stations will be members of Hunt Group 270
configured in Figure 4. The stations (IR ports) will automatically log into the split via the Agent
LoginlIDs configured as shown in Figure 6. When using the Voice over IP interface on Avaya
IR, the ports are configured as 7434ND stations.

add station 79110 Page 1 of 4
STATION
Extension: 79110 Lock Messages? n BCC: 0
Type: DS1FD Security Code: TN: 1
Port: 01A0910 Coverage Path 1: COR: 1
Name: Avaya IR Port 10 Coverage Path 2: CoS: 1
Hunt-to Station: Tests? y

STATION OPTIONS
Time of Day Lock Table:
Loss Group: 4
Off Premises Station? y
R Balance Network? n

Survivable COR: internal
Survivable Trunk Dest? y
R Balance Network? n

Figure 3: Station for Avaya IR Port

The Avaya IR ports, configured as DS1FD stations, will automatically log into Hunt Group 270
configured in Figures 6 and 7. Set the Group Extension field to a valid extension and enable
the ACD and Vector options. This hunt group will be specified in the Agent LoginIDs
configured in Figure 6 and 7.

add hunt-group 270 Page 1 of 3
HUNT GROUP

Group Number: 270 ACD? y
Group Name: Nuance OSA (T1) Queue? y
Group Extension: 77000 Vector? y

Group Type: ucd-mia

TN: 1

COR: 1 MM Early Answer? n
Security Code: Local Agent Preference? n

ISDN/SIP Caller Display:

Queue Limit: unlimited
Calls Warning Threshold: Port:
Time Warning Threshold: Port:

Figure 4: Hunt Group for Avaya IR Ports (Page 1)
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On Page 2 of the Hunt Group form, enable the Skill and AAS options. The AAS option will
allow the IR ports to automatically log into the hunt group via the Agent LoginIDs.

add hunt-group 270 Page 2 of 3
HUNT GROUP
Skill? y Expected Call Handling Time (sec): 180
AAS? y Service Level Target (% in sec): 80 in 20
Measured: both Service Objective (sec): 20
Supervisor Extension: Service Level Supervisor? n

Controlling Adjunct: none

VuStats Objective:
Timed ACW Interval (sec): Dynamic Queue Position? n
Multiple Call Handling: none

Redirect on No Answer (rings) :
Redirect to VDN:
Forced Entry of Stroke Counts or Call Work Codes? n

Figure 5: Hunt Group for Avaya IR Ports (Page 2)

Add an Agent LoginlID for each IVR port. The AAS option is enabled and the Port Extension
IS set to the extension of the stations corresponding to each Avaya IR port. Repeat this
configuration for each DS1FD station. In this configuration, agent login IDs 29110 to 29123
were created.

add agent-loginID 29110 Page 1 of 2
AGENT LOGINID
Login ID: 29110 AAS? y
Name: IR Port 10 AUDIX? n
TN: 1 LWC Reception: spe
COR: 1 LWC Log External Calls? n
Coverage Path: AUDIX Name for Messaging:
Security Code:
Port Extension: 79110 LoginID for ISDN Display? n

Auto Answer: station
MIA Across Skills: system
ACW Agent Considered Idle: system
Aux Work Reason Code Type: system
Logout Reason Code Type: system
Maximum time agent in ACW before logout (sec): system
Forced Agent Logout Time: 8

WARNING: Agent must log in again before changes take effect

Figure 6: Agent LoginID for IVR Ports (Page 1)
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On Page 2 of the Agent LoginID form, set the skill number (SN) to hunt group 270, which is the
hunt group (skill) that the Avaya IR ports will log into.

add agent-loginID 29110 Page 2 of 2
AGENT LOGINID
Direct Agent Skill: Service Objective? n
Call Handling Preference: skill-level Local Call Preference? n
SN RL SL SN RL SL SN RL SL SN RL SL
1l: 270 1 16: 31: 46 :
23 17: 32: 47 :
B 18: 33: 48:
4. 1L.E) g 34: 49:
53 20: BIoE 50 3
6: 21: 36: 51:
7 : 22 37: 52 3
8: 23: 38: 53:
©¢ 24: BIOE 54:
10: 253 40: 553
11: 26: 41 : 56 3
12: 27: 42 57:
13: 28: 43: 58:
14 : 2C) g 44 519K
15: 30: 45: 60:

Figure 7: Agent LoginID for Avaya IR Ports (Page 2)

Incoming calls will be routed to VDN 75200 based on the DNIS. VDN 75200 will invoke vector
200 which will queue the call to the hunt group containing Avaya IR ports. Avaya IR will
invoke the Nuance OSA application and wait for the transfer-to number. Use the add vdn 75200
command to create the VDN that will handle all incoming calls.

add vdn 75200 Page 1 of 3
VECTOR DIRECTORY NUMBER

Extension: 75200
Name*: Nuance OSA
Vector Number: 200

Attendant Vectoring? n
Meet-me Conferencing? n
Allow VDN Override? n
COR: 1
TN#*: 1

Measured: none

Service Objective (sec): 20
VDN of Origin Annc. Extension¥*:
1st Skillx*:
2nd Skillx*:
3rd Skill*:

* Follows VDN Override Rules

Figure 8: Vector Directory Number (VDN)
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VDN 75200, configured above, will invoke vector 200 which will queue the call to the hunt
group 270. The converse-on step is used to pass the ANI and VDN numbers. Avaya
Communication Manager will then collect the transfer-to number sent by Nuance OSA.
Configure vector 200 as shown below. These steps are required when using a T1/Robbed-Bit
Signaling interface. When using a VVoice over IP interface on Avaya IR, the call is routed to the
hunt group using a queue-to skill step. The converse-on and collect steps should not be used.

change vector 200 Page 1 of 6
CALL VECTOR
Number: 200 Name: Nuance OSA (T1)
Attendant Vectoring? n Meet-me Conf? n Lock? n

Basic? y EAS? y G3V4 Enhanced? y ANI/II-Digits? y ASAI Routing? y
Prompting? y LAI? y G3V4 Adv Route? y CINFO? y BSR? y Holidays? n
Variables? y 3.0 Enhanced? y

01 wait-time 2 secs hearing ringback

02 converse-on skill 270 pri h passing ani and vdn

03 collect 16 digits after announcement none for none
04 route-to digits with coverage y

05 stop

06

Press 'Esc f 6' for Vector Editing

Figure 9: Call Vector

Configure the Converse Data Return Code field on the Feature-Access Codes form as shown in
Figure 10.

change feature-access-codes Page 6 of 7
FEATURE ACCESS CODE (FAC)

Call Vectoring/Prompting Features

Converse Data Return Code: #12

Vector Variable 1 (VV1l) Code:
Vector Variable 2 (VV2) Code:
Vector Variable 3 (VV3) Code:
Vector Variable 4 (VV4) Code:
Vector Variable 5 (VV5) Code:
Vector Variable 6 (VVé6) Code:
Vector Variable 7 (VV7) Code:
Vector Variable 8 (VV8) Code:
Vector Variable 9 (VV9) Code:
Figure 10: Feature Access Codes
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3. Configure Avaya Interactive Response (IR)

This section covers the configuration of Avaya IR. Avaya Communication Manager routes
incoming calls to Avaya IR over a T1 interface. Each channel of the T1 interface is assigned a
phone number that should match the corresponding station extensions configured on Avaya
Communication Manager and an Avaya IR VoiceXML application. Refer to [3] for additional
information on Avaya IR.

The configuration steps required on Avaya IR are summarized below.

= Access the Avaya IR via a web browser and log in.

= Stop the Voice System (i.e., Avaya IR) prior to configuring the T1 interface.
= Configure the T1 interface to the Avaya G650 Media Gateway.

= Administer and assign an ASR and TTS engine.

= Start the Voice System.

= Assign channels to equipment groups.

= Assign phone numbers to channels.

= Assign services (VoiceXML applications) to channels.

Note: The Nuance OSA solution is also supported with a Voice over IP interface between
Avaya IR and Avaya Communication Manager. However, the focus of these Application Notes
is on the T1 interface.

The packages installed on Avaya IR are displayed below. To verify which packages are installed
on Avaya IR, use the “pkginfo | grep AV” command from the command line.

devconlr3 (root) # pkginfo | grep AV

IVR AVbackrst Backup/Restore Utilities

IVR AVitst Feature Test Script Package

IVR AVir Interactive Response Base System
IVR AVjdbcint JDBC Integration

IVR AVlm License Manager

IVR AVmrcpasr MRCP ASR Proxy

IVR AVmrcptts MRCP TTS Proxy

IVR AVnms NMS Package

IVR AVsc Service Creation Integration Package
IVR AVSproxy Speech Proxy Base Software

IVR AVSrproxy Speech Proxy SR - Speech Recognition
IVR AVtsm Transaction State Machine

IVR AVttsprxy Proxy Text-to-Speech Package

IVR AVucid Universal Call ID

IVR Avval Avaya IR System Validation Package
IVR AVvoicxml2-0 Voice XML Interpreter

IVR AVvoip Voice Over IP

IVR AVwebadm Web Administration

IVR AVweblm WebLM Server

IVR Avxfer Call Transfer and Bridge Package

Figure 11: Installed Avaya IR Packages
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The Avaya IR configuration was performed via a web browser. Enter the IP address of Avaya
IR in the URL field of the web browser. The initial Avaya IR webpage is displayed as shown in
Figure 12. Select the Web Administration link to display the log in screen (not shown), and
log into Avaya IR with the appropriate credentials.

€] Avaya Interactive Reponse - Microsoft Internet Explorer [._][E]ﬁ
File Edit Wew Favorites Toolz Help al'

@Eack - \_:J @ @ h;j pSEErm ‘*E_._-lz—‘ Favorites @ [\/i::{- ; ILJ_.-FI - if

Address | 4] http://192.45.121, 125/ vE)co Lnk ™

&)
AVAyA Avaya Interactive Response 3.0

Administration Web Pages

¢ Web Administration

¢ WeblM Primary Server
¢ WeblM Secondary Server
+ Help

© 2007 Avaya Inc. All Rights Reserved.

@ Done “'_ﬂ Local intranet
Figure 12: Initial Avaya IR Screen

(]
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After successfully logging into Avaya IR, the main Avaya IR configuration webpage is displayed
as shown in Figure 13.

@ Avaya IR Administration - Microsoft Internet Explorer I._HE]W
File Edit View Favorites Tools Help a"

»

@Eack - '».._,:‘I E @ :_;j pSearch ‘};n'\?l:avorites @ Erjgv .,; I!ﬂ_.?l =

Address |@ hittps://192.45. 121, 125:8443/admin/admin. hml M Go  Llinks @

AVAYA Avaya Interactive Response 3.0

Administration Web Pages

Help Log out

ASG Security Administratior
ASG Security Login Admin
Backup/Restore
Backup
Backup Scheduling | |
Delete Backup Files ]
Backup History
Default Backup Paramete
Restore FEEXEXFXFRE NOT[CE FFEFFEFEEEEL TR TS
Configuration Management
Alarm Administration
Alarms
Dialout Configuration
CDH Scheduling
Feature Licensing
License Configurations
JDBC Administration
Message Administration
VXML Log Administration
System Control EEEEEEEEEEE B g
Renumber Voice Channe| LSS
Report Voice System Sta
Start Voice System
Stop Voice System
Switch Interfaces
Digital Interfaces
Voice over IP
Voice Equipment
Display Equipment
Equipment State
Channels to Groups ||
Phone Number ™ System Status
Display Passwords
Voice Services
Channel Services
Number Services
Feature Packages
Speech and DPR Administ
Display Status
Administration
Universal Call ID Administ
Reports
Call Data Handling Reports
Message Log Report
VXML Log Report
VXML Performance Log Re
ROI-TCO Feature
ROI-TCO Administration
ROI-TCO Call Cost
Upload ROI-TCO data
ROI-TCO Reports M

Backup Information

No complete backup has been done.
Mo partial backup has been done.

It is recommended to perform a full system backup every 30
days.

If yvou fail to do so, you risk losing information on the system
in the event of a catastrophe.

[i] 11} [ll

Normal mode

[i] I | [l]
@ Daone é ‘d Local intranet
Figure 13: Main Avaya IR Webpage
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Prior to configuring the T1 interface to the Avaya G650 Media Gateway, stop the Avaya IR by
selecting the Stop Voice System link from the left pane in Figure 13. The Stop Voice System
page is displayed. Click the Submit button and wait until the system displays a message at the
bottom of the page indicating that the voice system has completely stopped.

To configure the T1 interface to the Avaya G650 Media Gateway follow these steps:

1. Under Switch Interfaces in the left pane, select the Digital Interfaces option to display the
Digital Interfaces Protocols page.

2. Select the Assign Card link to display the Assign Card page shown in Figure 14. On this
page, set the Card field to the appropriate number, set the Card Type field to T1, and set the
Trunk 1 field to Loop Start T1. When complete, click the Submit button to display the
Assign Card 1: Type T1 page shown in Figure 15.

&] Avaya IR Administration - Microsoft Internet Explorer g@
File Edit View Favorites Tools Help .'f

@Eack - \_/l Iﬂ Iﬁ _h /:__j Search ‘-Ej:( Fawvorites @ [?-:' h::._,- r'”_fl T J ﬂ ﬁ

Adcress | ] https://192.45. 121, 125:8443admin/admin.him | B ks ™

AVAyA Avaya Interactive Response 3.0

Administration Web Pages

Help Log out

ASG Security Administratior
ASG Security Login Admin
Backup/Restore fou are Here
Backup
Backup Scheduling | |
Delete Backup Files |
Backup History
Default Backup Paramete
Restore
Configuration Management

A.Ia FIT Ad“‘i“istratiﬂ“ . ..\' T . -\'
Alarms Card: Card & -
| i 1 | Y -1 .

Dialout Configuration . ]
CDH Scheduling Trunk 1: | Loop Start T1 _

Feature Licensing .
License Configurations Trunk 2: | None M

JDBC Administration

Message Administration

System Control

onfiguration Management>Switch Interfaces>Digital Intefaces>Assign Card

Assign Card

Renumber Voice Channe

m ‘i] 1 | ‘l]

@ Done é ‘d Local intranet
Figure 14: Assign Card
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3. On the page shown in Figure 15, set the Frame Type field to D4 and the Line Code field to
AMI_ZCS. Accept the default for the other fields as shown in the figure. Click the Submit
button.

€] Avaya IR Administration - Microsoft Internet Explorer "_”E]ﬁ
File Edit WView Favorites Tools Help a’

Qus- © [ G P Jorowe @ 2- 55 - I B

Address |@ https://192.45. 121, 125:8443/admin/admin.html M Go Links ®

AVAyA Avaya Interactive Response 3.0

Administration Web Pages

Help Log out

ASG Security Administratior
ASG Security Login Admin
Backup/Restore
Backup
Backup Scheduling
Delete Backup Files
Backup History
Default Backup Paramete
Restore
Configuration Management
Alarm Administration Common Parameters:
Alarms ;
Dialout Configuration Idle Code: 11111 Length: 0

CDH Scheduling y
Feature Licensing Clock Trunlk: Clock Source: NETWORK
License Configurations - : : )
JDBC Adminisgratiun Clock Mode: STANDALONE Clock Fallback Trunk: m
Message Administration ] )
VXML Log Administration Fax Enabled?:
System Control
Renumber Voice Channel
Report Voice System Sta| .
Start Voice System LOCI[] Start T1: .
Stop Voice System Country: United States |+
Switch Interfaces )
Digital Interfaces Trunkl
Veoice over IP
Voice Equipment
Display Equipment
Equipment State

Channels to Groups

Display Passwords

=
&

Enabled Channels: 48 (0 to 48)

Line Code:

Frame Type:

E i
<] <]
<]

é ‘ﬁ Local intranet

Figure 15: Assign Card Parameters

JAO; Reviewed: Solution & Interoperability Test Lab Application Notes 13 of 37
SPOC 7/28/2008 ©2008 Avaya Inc. All Rights Reserved. Nuance-OSA-IR



Next, configure the Automatic Speech Recognition (ASR) server in Avaya IR by selecting the
Administration option under Speech and DPR Administration in the left pane and then
selecting Speech Recognition and DPR Configuration. For this solution, a Nuance Speech
Server was used as the ASR server. The ASR server should be configured as shown in Figure
16. The following Speech Recognition and DPR Configuration webpage is shown after it was
already configured. The Engine field should be set to mrcp-scansoft, the Server Name field
should be set to <IP Address>/media/speechrecognizer, and the IP Address field should be set
to the IP address corresponding to the Nuance Speech Server. Furthermore, the Ports field
should be set to the number of ports available on the speech server according to its installed
license and the Base Port field should be set to 4900.

] Avaya IR Administration - Microsoft Internet Explorer

BEX]

File Edit Wiew Favorites Tools Help
N A .‘_ _ln\_ . /_‘—\ '_\ F
Que - ©  [x] @ @ Pseaer Jrraws @ (- - J K B
Address |@ https://192.45. 121, 125:8443/admin/admin.html M Go Links ®
AVAy/_\ Avaya Interactive Response 3.0
Administration Web Pages
Help Log out
System Control
Renumber Voice Channel - o I Y (I —
Report Voice System Sta :_-,, El -PE‘E :,Ef :E_F DPR A on*Administration>=5Speec
Start Voice System T - o o
Stop Voice System -
Switch Interfaces Speech Recognition and DPR
Digital Interfaces - -
Voice over IP Configuration
Voice Equipment
Display Equipment -
Equipment State Recognition Type: | OPSR4 i
Channels to Groups g e .
Phone Number Engine: mrcp-scansoft
Display Passwords
Voice Services | unassin |
Channel Services
Number Services -
Feature Packages Assign New Server
Spe_ech and DPR Administ
D'SPI_B? Status Server Name: 192.45.122.134/media/speechrecognizer
Administration -
Universal Call ID Administ Server Type: Primary
Reports .
Call Data Handling Reports IP Address: 192.45.122.134
Message Log Report Ports: 4
CELA g e Base Port: 4300
VXML Performance Log Re| —
ROI-TCD Feature Backup Server: Not Specified
ROI-TCO Administration
ROITCO Call Cost | unassion |
Upload ROI-TCO data
3 ——
@ Daone = ‘:J Local intranet
Figure 16: Speech Recognition and DPR Configuration
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To Configure the Text-to-Speech (TTS) engine in Avaya IR, select the Administration option
under Speech and DPR Administration in the left pane and then select Text-to-Speech
Configuration. For this solution, a Nuance Speech Server was used as the TTS server. The
TTS server should be configured as shown in Figure 17. The following TTS configuration
webpage is shown after it was already configured. In this configuration, the default voice of jill
was used. The Engine field should be set to mrcp-scansoft, the Server Name field should be set
to <IP Address>/media/speechsynthesizer, and the IP Address field should be set to the IP
address corresponding to the Nuance Speech Server. Furthermore, the Ports field should be set
to the number of ports available on the speech server according to its installed license and the
Base Port field should be set to 4900.

=
€] Avaya IR Administration - Microsoft Internet Explorer g@
File Edit View Favorites Tools Help :,'
b L] = it ~ =
- ) < i (- & - f o
e Back </ \ﬂ @ f A - Search . ¢ Favorites 6‘3 =2 & =] rii 5
Address (] https:/{192.45, 121, 125:8443 admin/admin html ]| BYeo ks >
A\/AyA Avaya Interactive Response 3.0
Administration Web Pages
Help Log out
Hessage Admint
VXML Log Adm - ~ L L T - -
System Control _:'_ are Here: Feature Packages>Speech and DPR Administration>Administration>Text-to-Spee
Renumber Voice Channel -
Report Voice System Sta B
Start Voice System - — 1 1
S, ek i Text-to-Speech Configuration
Switch Interfaces
Digital Interfaces
Voice over IP Default Voice: jill
Voice Equipment
Display Equipment -
Equipment State Text-to-Speech Type: | TTS0
Channels to Groups i :
Phone Number Engine: mrcp-scansoft
P | change [ unassion |
Voice Services Change
Channel Services
Number Services =
Feature Packages Assign New Server
Speech and DPR Administ
Display Status Server Name: 192.45.122.134/media/speechsynthesizer
Administration -
Universal Call ID Administ| Server Type: Primary
Reports _ IP Address: 192.45.122.134
Call Data Handling Reportg
Message Log Report Ports: 4
VXML Log Report Base Fort: 4900
VXML Performance Log Re —
ROI-TCO Feature Backup Server: Not Specified
ROI-TCO Administration m
ROI-TCO Call Cost L3
Upload ROI-TCO data
ROI-TCO Reports
Ea I
£ 1 | [l]
@ Daone é ‘:} Local intranet

Figure 17: Text-to-Speech Configuration Summary

After the T1 card and speech server are successfully configured, start the Avaya IR by selecting
Start Voice System under System Control in the left pane. Before proceeding, wait for the
system to display a message indicating that the startup of the voice system is complete.
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Next, assign the channels of the T1 card to equipment group ‘2°. Select the Channels to
Groups option under Voice Equipment in the left pane, and then select the Assign link to
display the Assign Channels to Equipment Groups page shown in Figure 18. Assign group
‘2’ to channels 0-23, which corresponds to the 24 T1 channels, and then click Submit.

€] Avaya IR Administration - Microsoft Internet Explorer "_"E]ﬁ
File Edit Wiew Favorites Tools Help #

Que - © Q@G P Freme @3- % 5 - B

Address |@ https:/{192.45. 121, 125:8443/admin/admin.html M Go Links >

AVAyA Avaya Interactive Response 3.0

Administration Web Pages

Help Log out

Message Administration

VXML Log Administration

System Control
Renumber Voice Channel

s ekl MW Assign Channels to Equipment
Start Voice System ]

You are Here: Configuration Management>Voice Equipment>Channels to Groups>Assign

Stop Voice System Grou ps
Switch Interfaces

Digital Interfaces

Voice over IP Channels: |0-23
Voice Equipment

Display Equipment Groups: |2

Equipment State
Channels to Groups

b

Display Passwords

< - i | (]

@ Done é ‘ﬂ Local intranet

Figure 18: Assign Channels to Equipment Groups
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After assigning channels to groups, assign phone numbers to channels. Select the Phone
Number link under Voice Equipment in the left pane to display the Phone Number — Channel
Assignment page and select the Assign link. Assign phone numbers 79110 to 79123 to channels
0 to 23, respectively, as shown in Figure 19 and then click Submit. Essentially, the extensions
of the DS1FD stations configured in Figure 3 are assigned to each T1 channel.

€] Avaya IR Administration - Microsoft Internet Explorer g@
File Edit Wew Favorites Tools Help l'.-"

egack > \,_/l @ @ _;j ;j Search {?Favorit&s E} [‘::<' h:\_;; ] - _J ﬂ ﬁ

Address |@ https://192.45. 121. 125:8443 /admin fadmin. himl M Go | Links *

AVAyA Avaya Interactive Response 3.0

Administration Web Pages

Help Log out

SI0p VOICE bystem
Switch Interfaces
Digital Interfaces

ou are Here: Configuration Management>Vaice Equipment>Phone Number>Assign
Voice over IP
Voice Equipment -
Display Equipment ®m_  Assign Phone Number to a
Equipment State [ |
Channels to Groups ChannEI

Phone Number
Display Passwords
Voice Services Phone Number: 79110 to |79123
Channel Services
Number Services
Feature Packages . .
Speech and [?F‘R Administ WoIP H.323 Multivantage Station Password: to
Display Status
Administration

Universal Call ID Administ] I Submit m m
Reports

Call Data Handling Reports
Message Log Report
VXML Log Report

Channel Number: 0 to |23

@Done 5 ‘QLomI intranet
Figure 19: Assign Phone Number
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Now, assign a Nuance OSA application to a channel (e.g., channel 9 was chosen arbitrarily for
this example). This specifies which application a particular Avaya IR channel would run when it
receives an incoming call. Select Channel Services from the left pane to display the Channel
Services page in Figure 20. Enable the checkbox for channel 9 and then click the Assign
Selected button.

€1 Avaya IR Administration - Microsoft Internet Explorer [._"E]m
File Edit View Favorites Tools Help al

@Badc . \__) @ @ \h;j pSearch {?Favorites @ [‘?{' D._.,- vl - ,_J ﬁ 'ﬁ

Address @ https://192.45. 121. 125:8443/admin/admin.htm M Go | Links

AVAYA Avaya Interactive Response 3.0

Administration Web Pages

Help Log out

JUBLC Administration

Message Administration

VXML Log Administration You are Here: Configuration Management>Voice Services>Channel Services

System Control
Renumber Voice Channe |
Report Voice System Sta ]
Start Voice System

Channel Services

Stop Voice System
Switch Interfaces
Digital Interfaces
Voice over IP
Voice Equipment
Display Equipment
Equipment State
Channels to Groups
Phone Number
Display Passwords
Voice Services
Channel Services
Number Services
Feature Packages
Speech and DPR Administ

i
3
@
[a

Chan Service/URI Tvpe Startup Service/URT Tvpe

0 - unassigned - unassigned

unassigned - unassigned
unassigned - unassigned
unassigned - unassigned
unassigned - unassigned
unassigned - unassigned

unassigned - unassigned
Display Status
Administration
Universal Call ID Administ
Reports
Call Data Handling Reports

unassigned - unassigned

unassigned - unassigned

OO0 O0O00OooOoodd
[ - (N7, TR S R KR

igned - igned
Message Log Report unassig unassig

VXML Log Report

VXML Performance Log Re 1 . 1
ROI-TCO Feature < Channel Range: | (0-9) _ Dlsplay channels.

ROI-TCO Administration
ROI-TCO Call Cost - -
Upload ROI-TCO data u Unselect All Assign Selected Unassign Selected
< e | (2]
@ Done =] ‘ﬂ Local intranet

Figure 20: Channel Services
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Configure the Assign Services to Channels page as shown in Figure 21. This configuration
assigns the Nuance OSA application named to channel 9. Set the Assign field to VXML URI, set
the URI field to
http://192.45.122.135:8080/OpenSpeech/Attendant/servlet/aa?avaya_inband_anidnis=anything
&avaya_acm_fac=%2312, and set the To Chan(s) field to ‘9’. The required parameters in the
VXML URI allow the ANI and DNIS to be passed to the Nuance OSA and also specify the
Converse Data Return Code of ‘#12” configured in Figure 10. Repeat this procedure for all
channels that should run this application. Note that the user may change the To Chan(s) field to
0-23 to assign the application to the 24 T1 channels in a single step. Click Submit.

€] Avaya IR Administration - Microsoft Internet Explorer Q@
File Edit Wiew Favorites Tools Help '1."

esad‘ . \_/J \ﬂ @ _;j /:__\J Search ‘5:{ Favorites @ [j_:' :_; 7 _J ﬂ ﬁ

Address | @] https://192.45. 121, 125:8443/admin/admin.html v Beo ks

AVAyA Avaya Interactive Response 3.0

Administration Web Pages

Help Log out

Message Administration

VXML Log Administration - . B . ) .

SvstEl-“ |:o“tro| You are Here —anriguration 'E"E;E"‘E nt=Voice Services>Channel S5er :EE:“—E:‘;" Services to
Renumber Voice Channel ST
Report Voice System Sta
Start Voice System .
Stop Voice System [ ]

Switch Interfaces
Digital Interfaces ;
Voice over IP Acscsign: [ VXML URI

Voice Equipment ;

Display Equipment URI: http://192.45.122.135:8080/0penSpeech/Attendant/se
Equipment State

Channels to Groups To Chan(s): g

Phone Number

Display Passwords

Channel Services

Number Services
Feature Packages

Assign Services to Channels

=] gLoml intranet
Figure 21: Assign Services to Channels — VXML Application
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To view the status of the channels and the channel configuration details, select Display
Equipment from the left pane. The page in Figure 22 is displayed. Verify the state of the
configured channels. In this configuration, channels 0-23 are in-service and channel 9 was
assigned to the Nuance OSA application. Channel 9 is assigned phone number 79110.

@] Avaya IR Administration - Microsoft Internet Explorer g@
Fle Edit WView Favorites Tools Help ",'

Qus - © M A G Lot frroom @ 2- 2 @ - JEL B

Address | ] https://192.45. 121, 125:8443/adminadmin htrl B s ™

AVAYA Avaya Interactive Response 3.0

Administration Web Pages

Help Log out

JUBU Admimistration
Message Administration
VXML Log Administration
System Control

CARD

1 STATE: Inserv CLASS: Digital NMS(T1) O_5_INDEX:

Renumber Voice Channe HAME: AGEZ QBETICNS: stendelone clocking, no tdm

Report Voice System Sta) FUNCTION: NMS
Start Voice System CARD TRUNE PORT CHAM STATE SERVICE-NAME PHCNE

1

"
o
&
=]

OPTS PROTOCOL

Stop Voice System 1 1 [ 0 Inserv 73101 z talk LOOE
Switch Interfaces 1 1 1 1 Inserv - = z telk LOOP
Digital Interfaces 1 1 2 2 Inserv - 2 talk LOOD
Voice over IP 1 1 2 3 Inserv - - z talk LOOD
Voice Equipment 1 1 4 4 Inserv - = z talk LOOP
Display Equipment 1 1 5 § Inserv - - z talk LOOD
Eﬂ'—"l"“r": Séate 1 1 & & Inserv - - z talk LOOP
1anne's to troups 1 1 7 7 Inserv - - z talk LOOD
g:'s'_“:: N;:;Z?n::rds 1 1 8 8 Inserv - = z talk LOOE
\l’oiCF‘p'-';::-\,riCFs 1 1 5 3 Inserv AVRYARVHIO 75110 z telk LOOF
Channel Services 1 1 10 10 Insezv - - 2 talk LOOD
Number Services 1 1 11 11 Inserv - = 2 talk LOOP
Feature Packages 1 1 12 12 Inserv - - H talk LOOP
Speech and DPR Administ 1 1 13 13 Inserv - S z talk LOOD
Display Status 1 1 14 14 Inserv - - z talk LOOP
Administration 1 1 15 15 Inserv - = 2 talk LOOP
Universal Call ID Administ] 1 1 16 18 Inserv - = 2 talk LOOD
Reports _ 1 1 17 17 Inserv - = z talk LOOD
Call Data Handling Reports 1 1 18 18 Insezv - - z talk LOOD
;;’;ial?:g"lggp';':tport 1 1 13 19 Inserv - - z talk LOOP
VXML Performance Log Re e = :0 :0 SEESaT - < SRS ar )y
ROI-TCO Feature 1 1 21 21 Inserv - = z taelk LOOE
ROI-TCO Administration 1 1 2z 22 Inserv - - 2 talk LOOP
0.0 oo = 1 1 23 23 Inserv - = 2 talk LOOP u
w
&] Done S % Localintranet

Figure 22: Display Equipment

In Avaya IR, change the client.inet.connection.persistent parameter to ‘0’ in the default0.cfg,
defaultl.cfg, and default2.cfg files located in the /vs/data/vxml directory. Stop the voice system
with the stop_vs command and then restart the voice system with the start_vs command.
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4. Configure Nuance OpenSpeech Attendant

This section covers the procedure for configuring Nuance OpenSpeech Attendant (OSA). The
procedure includes the following areas:

= Administer settings in the Configuration Panel
= Administer transfer entries in the Phone Directory and Menu Editor
= Administer top-level menu in the Phone Directory and Menu Editor

Nuance OSA is configured through Admin Tools which can be started by navigating to
Start->Nuance->Admin Tools. The initial screen is displayed as shown in Figure 23.

Wi Admin Tools [_ O]

Op-wSpeech'

ATTENDANT

Start
Stop

b onitor

Prompt R ecaorder

Phone Directary and kenw Editor

Report Generator

— LI = N =
Load Mew Configuration

Backup / Restore

D ata import

Call Analyzer
Help

Figure 23: Admin Tools
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4.1. Administer Settings in the Configuration Panel

To open the Configuration Panel, click on this option in the Admin Tools window in Figure
23. The login prompt will be displayed to the user as shown in Figure 24. Log in with the
appropriate credentials using Level 2 access level.

Configuration password |

Aocess level

ILE'-.-'E| 2 j

Paszwiord

Ixxxxm1

Ok, Cancel

Figure 24: Configuration Panel Login Window

The Configuration Panel show in Figure 25 is displayed. The Configuration Panel allows the
transfer mode and operator extension number to be configured. Nuance OSA supports blind
transfers with Avaya IR. To enable OSA for blind transfers, set the Gateway Transfer Mode
Supervised and Gateway Transfer Mode Bridged fields to NO as shown in the figure below.
The Operator Extension Number field should be set to a valid extension on Avaya
Communication Manager. Click Apply.

&l Configuration panel - level 2

Eile Tools Help

Setting | | Current value | D efault LI Operator Extetsion Mumber
Mumber of Ports + & 1
E stemmal Yoice Mail Prefis %4001, 4001, I??guz
Extemal Yoice Mail Suffiz # #
Dialing Prefises for External Mumbers 9 9
Mumber of Digitz in Area Codes 3 3
Murber of Digitz in External Phone Mumbers 7 7
Drefault Transfer Optiohg SUPERVISED SUPERVISED
@ Gateway Transher Mode Supervized = N0 FROM EMTRY
@ Gateway Transfer Mode Bridged MO MO
Gateway Transfer Connection Timeout il 3R
Gateway Tranzfer Maximum Call Duration 36000 36000
Gateway Tranzfer Options Sting
Gateway Tranzfer Pause Character p p
Gateway Tranzsfer URI type TEL TEL

Gateway Transfer SIP URI suffis localhost: 5080 lozalhost: 5060

Transter Connect Service Prefix 8 8
Call Analyzer recorded channels -+ ALL MOME
Syztem Languages en-U5 en-U5
@ Dperator Estension Mumber s FRA02 0
TOD Operator Extengion Murnber 0 0
Speed-Dial Key 1 I} 0
Speed-Dial kep 2 9 9
Speed-Dial Kep 3 39

Restare |

Licenze |

2l |

“99 =
_>I_I

Figure 25: Configuration Panel
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Next, close the Configuration Panel. Activate the changes when prompted by the system as
shown Figure 26.

e N |

] You have made changes that require a swskem restart.
[ Do o wank to dao it nows

Figure 26: Activate Changes in Configuration Panel
The following window is displayed. Click OK.

Starting OpenSpeech Attendant

Qpenapesch Attendant skarkup in progress

Figure 27: Startup in Progress Window
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4.2. Administer Transfer Entries in Phone Directory and Menu Editor
From Admin Tools, click on the Phone Directory and Menu Editor option. Figure 28 is

displayed.
i Menu Editor =]
File Edit “iew Tools Help
BB B @ EGY  Gw 0 m TR ® e
enus Content of "'Toplewvel Menuh”
=-{E] Toplevel Mernu | 5L Mame | Department | Locati.. | SR [ Mumber | Phan.. [ D[ 4. |
E-I' Cellular Phones s
: Croft, Lara X Fra02 Office =
: F.ent, Clark X 2m Office =
: Marketing X Fra02 Office =
: Petrino, Fobert X G464 Office = kS
£ Sales X 03 Office X
: Smith, John M arketing X Fra03 Office =
: Smith, John Sales ® g Office =
1 entries selected |
Phone Directary | Drata import |
Figure 28: Phone Directory and Menu Editor
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Next, select File>New->Transfer Entry from the menu options. The Creating transfer entry
window is displayed as shown in Figure 29. Configure the First names and Last names for this
entry and set the Number to a valid extension. Enable the Access to personal functions and
Access to name recorder options and set the PIN fields so that this user can access the Personal

Administration Mode (PAM) to change their name recording. Click OK.

E‘f Creating transfer entry
Marme in directary I [~ Deactivated entiy
MHames i i
|Advanced| Eall.t’-‘«ccountlng' Infolmatmnl S chedule Ip’-‘n.lways j
First names Middle names Last names Always |
Dravid Wellz »
— — — ¥ Speech recogrition
Mumber type Mumber 5 U FM# Priv
[ |Office > ||77305 FrrFr
r [ | == 1
Aliazes [Englizh [115])
Voice file status | Language | Allowr
@ Missing English [US) [V Access to personal functions
[# Yoice biometi MessagelNDne i Mew
Cusztomn Prompt
[~ Mever propose this name I““’"‘
Previous MNew st | 0k Carcel Apply
Figure 29: Creating Transfer Entry
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The new transfer entry is now displayed in the Menu Editor window, but the entry has not been
activated yet. Highlight the new transfer entry and then click on the Activate Changes icon.

il Menu Editor H=] E3

File Edit Wiew Tools Help

e N N S R I L

Menus Content of "Toplewel Menuh"
-5 Toplevel Menu | 31 Mame | Department | Locati.. | SR [ Mumber | Phan.. [ D.. | A |
E Cellular Phones .‘><
Craft, Lara ® Fra02  Office x
t Kent, Clark ® 2m Office =
t Marketing " a2 Office w8
t Fetring, Robert ® BaG64 Office = x
t Sales *® 7703 Office ®
t Srnith, John b arketing .‘>< Fra03 Office =
t Srnith, John Sales .‘>< a4 Office =
t wells, David * Office X,

1 entries seleched [

Phione Directary | Data import |

Figure 30: Menu Editor with New Transfer Entry

The following prompt is displayed to activate the new transfer entry so that it would be
recognized by Nuance OSA.

Change Activation

&n activation of the changes has been requested,

Figure 31: Change Activation
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4.3. Administer Top-Level Menu in Phone Directory and Menu Editor

Nuance OSA allows the configuration of multiple entry points. The use of multiple entry points
enable individual services or departments to be assigned a different entry point, which can be
configured using a DNIS or CLID number. When a call is received, Nuance OSA can route the
call to the appropriate entry point based on the dialed number (DNIS) or the caller’s phone
number (CLID). In this example, an entry point was configured using the DNIS option.

Create a new entry point by selecting File->New->Top-Level Menu from the menu options. The
window in Figure 32 is displayed. Enter a descriptive name in the Aliases field, enable the
Access to name recorder option, and set the PIN field for use with PAM. Click OK and
activate the changes.

E‘f Creating Menu
MHarme in directony I [~ Deactivated entry
Hames |Advanced| Call decounting | Information | Menu Behaviar | Secuity Access |
Schedule I.t’-‘n.lways j
First names Middle hames Last names

Accers code ||

v Call redirect pemitted

Drefault number

I.t‘-\ny type j
Conversation template
IDefauIt j_l
Aliazes [English [US]) Always |
DMIS Test

Settings |Greeting| F'r-:mpt' Bltemative F'r-:mptl Help A I *

v Speech recognition

IMenu behavior 1 j Mew |

Mumber of utterances Operator extension

Voice file status | Language | Al IDefauIt j I
@ Missing English (5] [~ Access to personal functions Mumber of zpellingz YWaoice profile
™ Woice biometrics IDefauIt j IDefauIt fram entry ijJ
V' Access to name recorder Mumber of interactions Barge-in function
Al IDefauIt j IDefauIt from enty poj
M thi I’""‘“—
M [zt oot i s [~ Alwaws ask for confirmation
[ Listing of entries
Frexvious 2 [ 2t | K Cancel Apply
Figure 32: Creating Menu
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From the Menu Editor, navigate to Edit-=>Ports and Entry Points to display the window in
Figure 33. Select the first item under Port assignment in the left pane and then select
Add->Entry Point from the menu options. Figure 34 is displayed.

E{ Ports and Entry Points B

Edit add Wiew

—Port aszignment I —Port group
=4 OCROOM:
Drefault Menu.Entry Pairit 1 Paits | DNIS/CLID Summaryl
P Mew entry point
i Unassigned
v v v v
POCROOM:1 POCROOM:2 POCROOM:23 POCROOM:4
v
POCROOM:&
[~ Show anly the entry poinks of I all j
Delete G Mew G
[~ Show anly the part groups of ] j ey St HekR |
Caomputer Management... | 0k | Cancel |
| |
Figure 33: Ports and Entry Points
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In the Ports and Entry Points window in Figure 34, set the Home menu and Main menu to the
new entry point configured in Figure 32. Select the DNIS/CLID tab and enter the pilot number
associated with the appropriate VDN configured on Avaya Communication Manager. Click OK.
In this example, this entry point will be used when Nuance OSA receives a DNIS of 75201.

Note that the configuration of VDN 75201 and its associated vector is not shown in these
Application Notes, but should be configured as shown in Figure 8 and Figure 9.

Edit Add Wiew
Part azsighment I Entmy paint
=l Ports : POCROOM:1.2,3.4.5 o -
i Diefault Menu Entry Point 1 Drescription INEW entry point
- Nev entry point Home men IDNIS Test j_l
. i Mew entry point )
.. Unassigned M ain menu IDNIS Test j_l
[~ Tianzter Connect
VUl Settings  DNIS/CLID |
DNIS |cLD
20 |
[~ Show anly the entry points of I all j
[~ Show only the port groups of ] j
Femave from Part Group Delete | Mew |
Computer Management.. | Ok | Cancel |
[Madified |
Figure 34: New Entry Point (DNIS/CLID Tab)
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In the VUI Settings tab, set the Voice Profile as shown below. Click OK.

E{ Ports and Entry Points E3

Edit Add  Wiew

—Port assignment I —Entry paint
El- Ports : POCROOM:1.2,3.4.5 L g
- Default Menu Entry Paint 1 Description INEW entry point
- Mew entry paint Home menu IDNIS Test j_l
-~ Mew entry paint _
Unassigned b ain menu IDNIS Test j_l

[~ Transfer Connect

WUl Settings | oIS ACLID |

Yaoice profile standard, female

[~ Express mode

" Barge-in off {* DTHMF is global
" Barge-n on after first greeting € DTMF is local ta EF
" Barge-in an after first prompt [ Allow DTMF pass through

% Bargein always Dperatar O peratar
on duty off duty

Mumber of utterances 2 | -

Humber of zpelings 0 |E 2 |

I Shaw only the entry paints of I Al j Humber of interactions L1 0 -

I~ Show only the part groups of ] j IR Vsl I j
Remowe from Paort Group | Delete | Mew |
Caomputer Managemernt... | ] | Cancel |
[Modified |

Figure 35: Ports and Entry Points (VUI Settings Tab)
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5. Interoperability Compliance Testing

This section describes the interoperability compliance testing used to verify the Nuance
OpenSpeech Attendant with Avaya Interactive Response. This section covers the general test
approach and the test results.

5.1. General Test Approach

The interoperability compliance test included feature and serviceability testing. Feature testing
focused on the ability of Nuance OSA to successfully recognize spoken names and extensions
entered via DTMF and transfer the call to the correct destination. Blind transfers were verified.

Serviceability testing focused on verifying the ability of the Nuance OSA to recover from
adverse conditions, such as server restarts, power failures, and disconnecting cables to the IP
network.

5.2. Test Results
All test cases passed.
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6. Verification Steps

This section provides the verification steps that may be performed to verify Nuance OSA with
Avaya IR.

1. From the Avaya IR web interface, verify that the Avaya IR channels are in-service as
shown in Figure 22.

2. From the Avaya Communication Manager SAT, verify that the T1 channels are in-
service using the status station <extension> as shown in Figure 36.

status station 79110 Page 1 of 3
GENERAL STATUS
Administered Type: DS1FD Service State: in-service/on-hook
Connected Type: N/A
Extension: 79110
Port: 01A0910 Parameter Download: not-applicable
Call Parked? no SAC Activated? no
Ring Cut Off Act? no
Active Coverage Option: 1

EC500 Status: N/A Off-PBX Service State: N/A
Message Waiting:
Connected Ports:

Limit Incoming Calls? no

User Cntrl Restr: none HOSPITALITY STATUS
Group Cntrl Restr: none Awaken at:
User DND: not activated
Group DND: not activated
Room Status: non-guest room

Figure 36: Status Station
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3. From the Avaya IR web interface, click on Display Status under Speech and DRP
Administration in the left pane to check the status of the Nuance Speech Server. In the
resulting page, select the Speech Resource Status link and then select the Resource
Status associated with the ASR server associated with the Nuance Speech Server (e.g.,
OPSR4). Click Submit. The following page will be displayed. Check that the ASR
ports are INSERV.

&) Avaya IR Administration - Microsoft Internet Explorer g@
File Edit Wew Favorites Tools Help |','

eBack - \,_,.)I @ @ _;j ;\] Search \E;‘E”Fauorites @ [‘?:{* :ﬁ ] - _J ﬁ 'ﬁ

address | ] htps://192.45. 121, 125:8443/admin/admin html v B ks

AVAyA Avaya Interactive Response 3.0

Administration Web Pages

Help Log out

LIdrnnels Lo Uruoups
Phone Number
Display Passwords
Voice Serwvices
Channel Services
Number Services SERVER: 192_45.122 134/media/speechrecognizer IPF: 1592_45.122.134
Feature Packages PORT CAPACITY: 4 PORTS AVAILABLE: 4
Speech and DPR Administ i s S S S
Display Status DORT STATE CHAN
Administration [
Universal Call ID Administ INSERV N/R

0

Reports 1 INSERV HN/&
z
3

RESOURCE: OPSR4 SUMMARY PORTS AVAILABLE: 4

call Data Handling Reports

Message Log Report INSERV HN/R

VXML Log Report INSERV HN/B

VXML Performance Log Re| M ———————————————————————

[TR—
@ é ‘ﬂLomI intranet
Figure 37: OPSR Status Summary

™
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4. From the Avaya IR web interface, click on Display Status under Speech and DRP
Administration in the left pane to check the status of the Nuance Speech Server. In the
resulting page, select the Speech Resource Status link and then select the Resource
Status associated with the TTS engine associated with the Nuance Speech Server (e.g.,
TTS0). Click Submit. The following page will be displayed. Check that the TTS ports

are INSERV.
€] Avaya IR Administration - Microsoft Internet Explorer E]@
File Edit View Favorites Tools Help 11'
@ Back - \_/I \ﬂ @ : ;\_| /:\J Search “z'i'( Favorites ﬁ‘} [_'\: - :L Iﬂ_fl - _J ﬁ ﬁ
Address @ https: {192, 45. 121, 125:8443 /admin/admin. html M Go  Llinks **
AVAyA Avaya Interactive Response 3.0
Administration Web Pages

Help Log out

Lidnnegis w aruoups
Phone Number
Display Passwords
Voice Services
Channel Services

RESQURCES: TTS
Default Voice:

3ill

TIS0 SUMMARY

Number Services
Feature Packages
Speech and DPR Administ
Display Status
Administration

TOTAL PORTS AVAILABLE: 4

SERVER: 1352 _45_122 134/media/speechasynthesizer
PORT CAPACITY: 4 PORTS AVAILABLE: 4

IP:- 152 _45_122_134

Universal Call ID Administ

PORT STATE CHREN
Reports
Call Data Handling Reports
Message Log Report g INSERV  N/2
VXML Log Report 1 INSERV  N/R
VXML Performance Log Re < INSERV N/&
ROI-TCO Feature 3 INSERV MN/& = 1
ROI-TCD Administration
20T TC0 Call Co [v) (v
I | 2] [« I 2]

é ‘:J Local intranet

Figure 38: TTS Status Summary

5. Place a call to Avaya IR and verify that the Nuance OSA application answers the call,
that the greeting is heard, and that the application is able to recognize the speech and
DTMF tones provided by the caller and transfer the call to the correct destination.

6. From Admin Tools on Nuance OSA, start the Monitor to verify that an active call is
detected as shown in Figure 39.

a Call monitoring on pocroom - Microsoft Interne... =] B3

Calls rmonitar for

27 callz zo far for pocroorn,
rna call in progress for farm
[comcurent peak 1, Tue Jun 17 12:12:22 EDT 2002)

192,45,121,125
IRITNTIN

Figure 39: OSA Monitor
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7. From the OSA Monitor, click on the system name (e.g., pocroom) to display a browser
window that can display the call log. Under Call logs in the left pane, click on Today
under From archive. Verify that the call log shown in Figure 40 is displayed with the
correct call information and status.

#3 Openspeech Attendant - Microsoft Internet Explorer M=

File Edit Wew Favorites Tools Help | :l'
Qback - £ - [ [ @@ | ) search <7 Favorites  £2 | - B

Address I@ http:/flocalhost: 8080/ Openspeechfdttendantserviet faa?action=statuss:

e ‘Links B
OMSpeech
ATTENDANT =

Hosted on pocroom

Description: Auto Attendant Wersion: 3.0.0 (GA) Build: 2008.04,10,12,58,04

|Ej Done

N

n e
Sections Logs from archive (on disk), 16 sessions last 15 calls 'l Dkl =
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Figure 40: Call Log
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7. Support

To obtain technical support for Nuance OpenSpeech Attendant, contact Nuance via email or
through their website.

= Web: www.network.nuance.com
= Email: SpeechAttendant.Support@nuance.com
= Phone: (866) 434-2564 or (514) 390-3922

8. Conclusion

These Application Notes describe the configuration steps required to integrate Nuance
OpenSpeech Attendant with Avaya Interactive Response (IR). All feature and serviceability test
cases were completed successfully.

9. Additional References
This section references the product documentation that is relevant to these Application Notes.

[1] Administrator Guide for Avaya Communication Manager, Document 03-300509, Issue 3.1,
February 2007, available at http://support.avaya.com.

[2] Feature Description and Implementation for Avaya Communication Manager, Document
555-245-205, Issue 5, February 2007, available at http://support.avaya.com.

[3] Avaya Interactive Response (IR) Release 3.0 Documentation Library, June 2007, available at
http://support.avaya.com.
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